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5 MacOrbits Application Help

1 Main Index

M acOr bits Help Index

Getting Started

An Introduction To CQuat Fractalsby Terry W. Gintz

M enus
File menu
Edit menu

| mage menu

Type menu
Demo menu

Video menu

Additional
Help topics

2 File Menu
Filemenu commands

The File menu offers the following commands:

New Creates a new drawing.

Open Opens an existing drawing.

Close Closes an opened drawing.

Save Saves an opened drawing using the same file name.
Save As Saves an opened drawing to a specified file name.

Save Quaternionto [OBJ]  Save polygonized quaternion as Wavefront object.

Save Quaternion to [POV]  Save polygonized quaternion as a POV-Ray triangle object.
Save Quaternionto [STL]  Save polygonized quaternion as STL solid file.
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File Menu 6

Save Quaternion to [DXF]  Save polygonized quaternion as AutoCad dxf file.

Export Setup Set maximum number of faces and vertices allocated for quad
export.

Load Texture [QTX] Load texture variables.

Save Texture [QTX] Save texture variables.

Load Text Format [MOT]  Load adatafile in text (platform independent) format.
Save Text Format [MOT]  Save adatafilein text (platform independent) format.

2.1 New command

New command (File menu)

Use this command to create a new drawing window in MacOrbits. Theimage and datafile
for the opening picture (title.png and title.vse) are used to create the new window.

Y ou can open an existing data/image file with the Open command.

2.2 Open command

Open command (Filemenu)
Use this command to open an existing data/image file in a new window.

Y ou can create new images with the New command.

2.2.1 File Open dialog box

File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.
Drives

Select the drive in which MacOrbits stores the file that you want to open.
Directories

Select the directory in which MacOrbits stores the file that you want to open.
Network...

Choose this button to connect to a network location, assigning it a new drive |etter.

2.3 Close command

Close command (Filemenu)

Use this command to close the window containing the active image. If you close a window
without saving, you lose all changes made since the last time you saved it.
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7 MacOrbits Application Help
2.4  Save command
Save command (File menu)
Use this command to save the active drawing to its current name and directory. When you
save adrawing for the first time, MacOrbits displays the Save As dialog box so you can name
your drawing. If you want to change the name and directory of an existing drawing before
you save it, choose the Save As command.
2.5 Save As command
Save Ascommand (File menu)
Use this command to save and name the active drawing. MacOrbits displays the
Save As dialog box so you can hame your drawing.
To save adrawing with its existing name and directory, use the Save command.
2.5.1 Save As dialog box
File Save Asdialog box
The following options allow you to specify the name and location of the file you're about to
save:
File Name
Type anew filename to save a drawing with a different name. MacOrbits adds the
extension .morb.
Drives
Select the drive in which you want to store the drawing.
Directories
Select the directory in which you want to store the drawing.
Network...
Choose this button to connect to a network location, assigning it anew drive |etter.
2.6  Save Quaternion to [OBJ] command

Save Quater nion to [OBJ] command (File menu)

Use this command to save a quaternion as atrue 3-D object. This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a quaternion formula, and then writes the
triangles to a Wavefront object file. The higher the precision, the smoother the finished
object becomes but the larger the object fileistoo. Precision is set with the Steps variable in
the Parameters window, where precision=10/Steps.
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2.7

2.8

Notes: some formulas produce asymmetrical object files with this routine, where one side of
the quad polygon isn't resolved completely. Usually one side is markedly smoother in this
case. If you enter afile name without an extension [obj] when saving an object the requester
doesn't check for afile with the same extension before overwriting it. (Thefile extension is
added later.) If you want to make sure you don't overwrite afile with an identical name, enter
the filename with the applicable extension. Quat-traps are not supported with this command.

Save Quaternion to [POV] command

Save Quaternion to [POV] command (File menu)

Use this command to save a quaternion as atrue 3-D object. This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a quaternion formula, and then smooths and
outputs the triangles to a POV-ray file. Thefile iswritten as a simple scene, the smooth
triangles part of a"union” object, with camera and lighting elements compatible with POV -
Ray 3.5. This can be used as a starting point for more complex compositions. The higher the
precision, the smoother the finished object becomes but the larger the object file is too.
Precision is set with the Steps variable in the Parameters window, where precision=10/Steps.

Notes: some formulas produce asymmetrical object files with this routine, where one side of
the quad polygon isn't resolved completely. Usually one side is markedly smoother in this
case. If you enter afile name without an extension [pov] when saving an object the requester
doesn't check for afile with the same extension before overwriting it. (Thefile extension is
added later.) If you want to make sure you don't overwrite afile with an identical name, enter
the filename with the applicable extension. Quat-traps are not supported with this command.

Save Quaternion to [STL] command

Save Quaternion to [STL] command (File menu)

Use this command to save a quaternion as atrue 3D object. This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a quaternion formula, and then writes the
trianglesto a STL solid file. STL files are used with 3D printers and other machinery. The
higher the precision, the smoother the finished object becomes but the larger the object fileis
too. Precision is set with the Steps variable in the Parameters window, where
precision=10/Steps.

Notes: some formulas produce unsymmetrical object files with this routine, where one side of
the quad polygon isn't resolved completely. Usually one side is markedly smoother in this
case. If you enter afile name without an extension [stl] when saving an object the requester
doesn't check for afile with the same extension before overwriting it. (Thefile extension is
added later.) If you want to make sure you don't overwrite afile with an identical name, enter
the filename with the applicable extension. Quat-traps are not supported with this command.
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2.9

2.10

2.11

2.12

Save Quaternion to [DXF] command

Save Quater nion to [DXF] command (File menu)

Use this command to save a quaternion as atrue 3-D object. This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a quaternion formula, and then writes the
triangles to an AutoCad dxf file. The higher the precision, the smoother the finished object
becomes but the larger the object fileistoo. Precision is set with the Steps variable in the
Parameters window, where precision=10/Steps.

Notes: some formulas produce asymmetrical object files with this routine, where one side of
the quad polygon isn't resolved completely. Usually one side is markedly smoother in this
case. If you enter afile name without an extension [dxf] when saving an object the requester
doesn't check for a file with the same extension before overwriting it. (The file extension is
added later.) If you want to make sure you don't overwrite afile with an identical name, enter
the filename with the applicable extension. Quat-traps are not supported with this command.

Export Setup

Export Setup (Filemenu)

Use this command to set max faces, the target object size, and max vertices, the maximum
number of indices that are allocated by the polygonizing routine. Defaults are 50,000 faces
and 5,000,000 vertices. Uselessto limit the size of the output file or the amount of memory
used while polygonizing. Use more if necessary for higher resolution object files. With
50,000 triangle faces the output file is approximately 1.6MB for the [obj] format.

Note: the max faces variable has no effect on the size of [Dxf] exports. Dxf-formatted objects
are saved without slimming.

Load Texture [QTX] command

L oad Texturecommand (File menu)
Use this command to load variables that make up the texture and noise parameters. Thisalso

loads the palette, coloring filter, orbit trap and coloring optionsin atexture file [qtx].

Save Texture [QTX] command

Save Texture command (File menu)

Use this command to save the variables that make up the texture and noise parameters for the
current figure. This also saves the palette, coloring filter, orbit trap and coloring optionsin
the texture file [qtx].
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2.13 Load Text Format [MOT]
Load adatafilein text (platform independent) format.
2.14 Save Text Format [MOT]

Save adatafile in text (platform independent) format.
3 Edit Menu

Edit menu commands

The Edit menu offers the following commands:

Undo Undo last edit or action.

Functions and Type Edit formula/type data.

Parameters Edit initial parameters.

Size Change size of image

Palette Edit color palette

Lighting Edit light point and Phong variables

3.1 Undo command

Undo command (Edit menu)

Use this command to undo the last action (except resizing.)

3.2 Functions and Type

Functionsand Type Window

Fun #1 and Fun #2 are popup menu controls for selecting up to two built-in formulas. There
are additionally a Type popup menu control, an Arg control, 'S (real) and 'S’ (imag) controls,
and an Arg Limit control that are used in various fractal types and formulas. User-defined
functions are supplied through popups controls fnl-fn4.

The Type control selectsavaue of 0to 9:

For avalue of 0, thefirst formulais always used and the second formulaisignored.

For avalue of 1, the second formulais processed and the first formulaisignored. Type 1is
of use only if you are switching between two functions and don't want to reenter them each

time you plot the other one.

For avalue of 2, thefirst formulais processed if the real component of Z is greater than 0O;
else the second formulais used.
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3.3

For value of 3, the first formulais processed and its output becomes the input of the second
formula, which is then processed.

Type 4 takes the average of Fun#l and Fun#2.

Type 5 aternates between the two functions while iterating.
Type 6 takes the quotient of both functions.

Type 7 uses the lowest iterative results of both Fun#l and Fun#2
Type 8 uses the highest iterative results of both Fun#l and Fun#2

Type 9 uses the Formula box to enter up to 150 characters per formula.
Text can be pasted from the clipboard to the formula box by using the keystroke apple-v.

About formula syntax: This appliesif you elect to enter your own formulainto one of the
function boxes and use the parser to generate the plot. The use of parenthesis is necessary
around complex exponents or variables. E.g.: '(z-i)*(1.5e)'. For acomplete list of variables,
operators and functions recognized by the parser, see Parser |nformation.
User-named-complex variables and constants may be included in aformula. A variable must
begin with aletter and may contain numbers and letters only. A variable may be up to 9
characterslong. A constant may be up to 20 digits long, including the decimal point.
MacOrbits uses syntax similar to Fractint's formula style with an initialization section,
followed by the main formula, and an optional bailout routine. Comments may be entered on
the same line with a proceeding ';'. These are provided to allow MacOrbits users to more
easily convert Fractint formulatypesto MacOrbitsuse. A "' terminates the initialization
section. Multiple phrases may be entered in the main formula or initialization sections on the
same line by using the terminator '," between phrases. Note: only a small subset of Fractint
variables are supported by MacOrbits, so complicated Fractint formulas may not work, or
could give misleading results.

Click on Draw to apply new formula options without closing the window. Click on Stop to
halt the drawing. Click on the Okay button to use the formulas currently displayed in the
window and redraw the figure, or Close to exit the window without making any further
changes.

Parameters

Parameter s
This command opens the formatting parameters window for the 2D/3D generator.
For 2D images only the bailout and iterations variables are used here.

Quad complex constants are cr, ci, ¢j and ck.
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Steps and Fine Tune are pitch adjustments that bear on the quality of the figure or model at
the expense of lengthier calculations and larger object files.

A larger bailout can increase the fullness of aquad figure. For 2D images reducing the
bailout below its standard value of 4 may help to eliminate excess detail. Iterations controls
the graininess and esthetics of the quad object. Higher iterations are generally not needed for
most quaternion images, but may be useful for increasing definition in 2D Julia and cquat
fractals.

Three rotate variables determine the 3D angle of rotation.

Click on Draw to apply new parameters without closing the window. Click on Stop to halt
the drawing. Click on the Okay button to use the parameters currently displayed in the
window and redraw the figure, or Close to exit the window without making any further
changes.

34 Size command
Size (Edit menu)

This alows you to set the drawing area for a picture, independent of the screen size. It aso
shows which sizeis currently in use. The aspect for the drawing is based on the ratio of a
drawing window's width to vertical height. The size of an image can have a standard 4/3 or
1/1 aspect from 240X 180 to 800X 800, or a custom aspect set by the W(idth) and H(eight)
boxes. Larger bitmap sizes can be created using the Image/Plot to File command

3.5 Palette command

Palette command (Edit menu)

Use the palette editor to modify the palette(s) in use. If the image has been drawn recently,
changes to the palette will show up immediately (colors are mapped to the active image.)
Otherwise the modified palette will take effect when you close the pal ette dialog and redraw
the image.

There are copy and spread options to smooth or customize the active image palettein
MacOrhits.

Colors are shown in 8 groups of 32 colors, or 256 color indexes total. Colors between the
indexes are interpolated so there are actually 256X 255 or 65000+ possible colorsin the
MacOrbits palette.

Use the RGB-dlider controls to edit any color in the palette. Select Copy to copy any color to
another spot in the palette. Select Spread to define a smooth spread of colors from the current
spot to another spot in the palette. Copy and Spread take effect immediately when you select
another spot with the mouse button. Y ou can cancel the operation with the Cancel button. In
MacOrhits, colors do not cycle smoothly when you adjust the RGB dliders. Thiswould be too
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3.6

slow with true color. The Map button is used to map color changes to an image after you are
done adjusting the dliders.

Use Reset to reset the colors of the palette in use, to where it was before it was modified.

Use Reverse to reverse the order of the colorsin the palette, excluding color index 1, the
background color.

Use Neg to create a pal ette that is the complement of the current palette, excluding color
index 1.

Use SRG to switch the red and green components of all palette colors except color index 1.
Use SRB to switch the red and blue components of all palette colors except color index 1.

Y ou can use these buttons to form eight different palettes by repeatedly switching red, green
and blue components.

Use the Random pal ette button to randomize the current palette.

Note: unless you click on Reset before exiting the editor, changes are permanent to the pal ette
edited, no matter which way you close the editor (Okay button or Close box.)

Lighting
Lighting Window

The LightPoint variables (lightx thru lightz) determine the direction of the light source used in
the ray-tracing algorithm. The ViewPoint represents the angle, at which the object is ray-
traced, which can affect Phong highlights greatly. This has no effect on the camera view.

The lighting variables Shininess, Highlight, Gamma, Diffuse and Ambient are used to adjust
ambient light and highlights. The ranges for these variables appear beside their |abel.
Decreasing the Shininess value increases light reflected by the quaternion and the apparent
sheen on the quaternion’s surface. The Ambient value controls the amount of ambient light
that illuminates the quaternion. The Highlight value increases or decreases the specular
(Phong) highlighting, while the Gamma value increases or decreases the intensity of the light
source'sillumination. Once aplot is drawn (in the current session), the lighting variables and
light point can be changed without redrawing the quaternion.

Click the Apply button to redisplay a plot after changing the lighting variables or light point.
Click the Okay button to close the lighting window, and apply new settings, if the variables
were modified. Click on Close to close the lighting window, keeping the current settings.

Image Menu

I magemenu commands

The Image menu offers the following commands:
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4.1

4.2

4.3

Draw Draw the figure.

Scan Scan Mandelbrot border for quaternion Julia set.

Zoom Zoom into or out of current image.

Plot to File Plot image to png file.

Reset Ranges Reset Z ranges.

Symmetry Horizontal, Vertical or XY Symmetry

Mapping Mapping controls how the bailout is processed for each pixel.

Draw command

Draw command (I mage menu)

Use this command to draw or redraw the image for the current fractal variables. Clicking
inside the draw window with the left-mouse button stops all plotting.

Scan command

Scan (Image menu)

Enabled when the Type is Mandelbrot. After executing this command, a small quaternion
Julia set is generated in the left upper corner, for the current quad constants and formula, and
each time you click in the draw window. Use the Mandelbrot border as a guide to finding
Juliasets. Generally if you click too far outside the Mandebrot borders the space occupied by
the Julia quaternion set vanishes. Most interesting are the Julia sets found right on the M-
border or just outside it.

Quaternion math is used where possible if the Type is set to Quaternion; else hypercomplex
math is used for the Hypernion type, etc.

Once you find an interesting quaternion set press the space bar and a new window is opened
that sets the fractal parameters to those in the exploratory gjuliawindow. (The parametersin
the scan window revert to their original Mandelbrot settings.)

Click on the status_bar area of the draw window to exit this command without generating a
new Julia set. (Parameters and bitmap revert to the previous state of the image.)

Zoom command

Zoom (I mage menu)

Turns on zoom mode, so that detail of the current plot may be magnified or centered.
Alternatively, just click inside any drawing window, move the mouse, and the zoom box will
appear. Using the mouse, move the zoom box over the portion of the plot you wish to
magnify. Hold the left mouse button (or left arrow key) to shrink the box or the right button
(or right arrow key) to enlargeit. Y ou may zoom in by defining a box inside the current
drawing area. Y ou zoom out by drawing a box outside the current drawing area. Use the up
arrow key to enlarge the zoom box X4 for quickly zooming outward or the down arrow key to
shrink the zoom box by 4. Y ou start azoom by pressing the space bar. The program opens a

© 2005-2008 -- Mystic Fractal



15

MacOrbits Application Help

4.4

4.5

4.6

new window and begins a new plot at the zoom coordinates. Y ou abort a zoom by pressing
the esc key (shift-esc with OS X 10.4) or click inside the status bar (bottom of draw window.)

For 2D plots you can also rotate the zoom box using the Tab and Enter keys. Holding the
Enter key down rotates the box clockwise and depressing the Tab key rotates the box counter-
clockwise. Thisis useful to allign some fractals horizontally, vertically or at any angle.

Note: repeated zoom is not available for Cloud fractals, but when using this command you
can"magnify" once a portion of the draw window, instead of altering the x/y ranges.

Plot to file

Plot to File (Image menu)

This allows you to plot alarge bitmap directly to a .png file without the added system
requirements of keeping the whole bitmap in memory (See below for exception.) The target
bitmapWidth can be 1024 to 14400 . Target Height is set by the drawing window aspect, or
Target_Height=draw_height/draw_width* Target Width. Click on Okay to set the target file
name and start a new plot to file, or Cancel to exit the window without plotting.

Note: The Cloud fractal is limited to 4800 width. Due the non-sequential nature of plotting
points for the Cloud fractal type, the entire image bitmap must be kept in memory.

Reset Ranges

Reset Ranges (Image menu)

The Reset Ranges command resets the real Z and imaginary Z ranges of an image to fit the
current drawing window's aspect. Thisis necessary when changing image size and the
drawing window aspect changes also, since a different aspect will otherwise stretch or
condense afigure. After reseting the ranges you may need to recenter or rezoom afigure.

Symmetry

Symmetry (Image menu)

This produces a mirror image from left to right (vertical) or top to bottom (horizontal) or both
(xy). You can zoom with symmetry, but the results will be uncertain if the zoom box is off-
center on the window.

Vertica symmetry
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Horizontal symmetry

XY symmetry

4.7  Mapping
Mapping
Mapping controls how the bailout is processed for each pixel.

Z-Real Mapping based on real part of z only.

Z-lmag Mapping based on imaginary part of z only.
Abs(Z-Real) Mapping based on absolute value of real part of z.
Abs(Z-Imag) Mapping based on absolute value of imaginary part of z.
Z-Real + Z-Imag Mapping based on sum of parts of z.

Abs(Z-Red)+Abs(Z-Imag) Mapping based on absolute value of parts of z.
>Abs(Z-Real) or Abs(Z-Imag) Mapping based on highest absolute value of parts of z.
<Abs(Z-Real) or Abs(Z-Imag Mapping based on lowest absolute value of parts of z.
Abs(Z) Mapping based on absolute value of z.

47.1 Z-Real

Z-Real
Map based on the real part of the complex number Z; used to map exponential Julia sets, etc.
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4.7.2

4.7.3

4.7.4

4.7.5

Z-lmag

Z-lmag
Map based on the imaginary part of the complex number Z.

Abs(Z-Real)

Abs(Z-Real)
Map based on the absolute value of the real part of the complex number Z; used to map
exponential Julia sets, etc.

Abs(Z-Imag)

Abs(Z-1mag)
Map based on the absolute value of the imaginary part of the complex number Z.

Z-Real+Z-Imag

Z-Real + Z-Imag
Map based on the sum of the real part and the imaginary part of the complex humber Z.
Changes the way banding appears in complex mappings.
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4.7.6 Abs(Z-Real)+Abs(Z-Imag)

Abs(Z-Real) + Abs(Z-Imag)
Map based on the absolute value of the real part plus the absolute value of the imaginary part
of the complex number Z. Changes the way banding appears in complex mappings.

4.7.7 >Abs(Z-Real) or Abs(Z-Imag)

>Abs(Z-Real) or Abs(Z-Imag)
Map based on the greater of the absolute value of the real part or the imaginary part of the
complex number Z. Works like alogical 'or', where either part of z must exceed zlimit to
break the iteration loop. Changes the way banding appears in complex mappings.

4.7.8 <Abs(Z-Real) or Abs(Z-Imag)

<Abs(Z-Real) or Abs(Z-Imag)
Map based on the lesser of the absolute value of the real part or the imaginary part of the
complex number Z. Works like alogical ‘and’, where both parts of z must exceed zlimit to
break the iteration loop. Changes the way banding appears in complex mappings.

47.9 Abs(2)

Abg(Z2)
Map based on the absolute value of the complex number Z (traditionally calculated by taking
the sgquare root of the sum of the squares of the real and imaginary parts of Z, but Fractal
Zplot uses only the 'sum’(modulus of z) for break-point tests.) The standard method of
mapping Julia and Mandelbrot sets.
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) Type Menu
Typemenu commands
The Type menu offers the following commands:
MandelbrotQ Mandelbrot set (orbit starts at zero.)
MandelbrotP Mandelbrot set (orbit starts at pixel.)
Julia Julia set.
3D Quaternion Set fractal typeto 3D quaternion.
3D Hypernion Set fractal type to 3D hypercomplex quaternion.
3D Cquat Set fractal type to 3D complexified quaternion.
2D Quaternion Set fractal typeto 2D quaternion.
2D Hypernion Set fractal type to 2D hypercomplex quaternion.
2D Cquat Set fractal type to 2D complexified quaternion.
Cloud Set fractal typeto 2D cloud
5.1 MandelbrotO
MandelbrotO (Type menu)
Mandelbrots base their mapping on varying inputs of complex C, which corresponds to the
min/max values set in the Parameters window. With MandelbrotO, the initial value of Z is set
to zero.
5.2 MandelbrotP
MandelbrotP (Type menu)
Mandel brots base their mapping on varying inputs of complex C, which corresponds to the
min/max values set in the Parameters window. With MandelbrotP, the initial value of Z is set
to the value of the pixel being iterated. Usually used with cubic Mandelbrot formulas.
5.3 Julia

Julia (Type menu)

Julia sets normally have a fixed complex C, with varying inputs of Z, which corresponds to
the min/max values set in the Parameters window.
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Julia from Mandelbrot

Julia set

5.4 3D Quaternion command

3D Quaternion (Type menu)

Use this command to set the fractal type to quaternion. Quaternion math is used to calcul ate
the 3D figure where possible, else hypercomplex math is used. When an orbit-trap method i<
also selected, a quat-trap fractal is generated.

5.5 3D Hypernion command
Hypernion (Type menu)

Use this command to set the fractal type to a hypercomplex 3-D quaternion. A hypernion
uses hypercomplex math to shape the 3-D object, which usually results in a squared-off shape,
rather than the rounded shape of the typical quaternion. When an orbit-trap method is also
selected, a quat-trap fractal is generated.

5.6 3D Cquat command
3D Complexified Quaternion (Typemenu)

Use this command to set the fractal type to a complexified quaternion. A cquat uses another
variation of quad math to shape the 3-D object, which usually results in a more chaotic shape
than the rounded lines of the typical quaternion. Not all formulas support the Complexified
Quaternion type. Inthat case, the formulawill default to hypercomplex algebra when this
typeis selected. When an orbit-trap method is also selected, a quat-trap fractal is generated.
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5.7

5.8

5.9

5.10

2D Quaternion command

2D Quaternion (Type menu)

Use this command to set the fractal type to 2D quaternion. Quaternion math is used to
calculate the 2D image where possible, else hypercomplex math is used.

2D Hypernion command

2D Hypernion (Type menu)

Use this command to set the fractal type to a hypercomplex 2D quaternion. A hypernion uses
hypercomplex math to generate the 2D image.

2D Cquat command

2D Complexified Quaternion (Type menu)

Use this command to set the fractal type to a complexified quaternion. A cquat uses another
variation of quad math to generate the 2D image, which usually resultsin a more chaotic
picture. Not al formulas support the Complexified Quaternion type. In that case, the
formulawill default to hypercomplex algebra when this type is selected.

Cloud

The cloud fractal type plots points based on the iterative value of each z. Points that overlap have
their color indexes incremented. This produces images that resemble fractal clouds. The Steps and
Iterations variables in the Parameters window are used to control the clouds resolution. The cloud
can be based on any built-in formula or a custom formula, with either the Mandelbrot or Julia type
selected. The Mandelbrot type tends to produce more flowery fractals, however.

Render Menu

Render menu commands

The Render menu offers the following commands:
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Coloring Filter Define coloring filter.

Palette Coloring Palette-based coloring options.
Noise Edit noise factors.

Texture Scale Set scaling factor for texture.

Generalized Coloring Generalized RGB-Coloring options.

6.1 Coloring Filter command

Coloring Filter

Here you define a coloring filter based on areal function. A generalization of Earl Hinrichs
sine-wave coloring method, the function can be any formula, up to 80 characters, that uses the
z-buffer variable and framing variables x and y. Sample function: .1*sin(z)+cos(x*x). The
Magnify slider is used to control the intensity of thefilter. Click on Apply to apply a new
coloring formulawithout closing the window. Click on Okay to close the window and apply
changes. Click on Cancel to close the window without applying changes. Use the Random
Filter button to generate arandom coloring filter. The best filters will use the z value and one
of the other variables (x or y.)

Quaternions normally use palette index one (the second index, zero being reserved for the
background color) for their predominant color, with pixel intensities/colors affected by the
lighting variables. When the coloring filter formulais defined, up to 235 colors can be used
(the full palette) to create mixed textures.

The trig and exponentia functions translated include sine (sin), arc sine (asn), cosine (cos),
arc cosine(acs), tangent (tan), hyperbolic tangent (th), hyperbolic sine (sh), hyperbolic cosine
(ch), log (log), natural log (In), power (pow), arc tangent (atn), absolute value (abs),
exponential (exp) and square root (sgr.)

The math functions are * (multiply),-(subtract),/(divide), and +(add).

The constants are Pl and E (In (1)), plus any floating-point number up to 9 digits (including
the decimal point).

The power function (x to the y power) is entered in standard notation: x"y', with optional
parenthesis necessary around complex exponents or variables.

Note: Range limits exist for arguments to these functions: exp, arc sine, hyperbolic sine, arc
cosine, hyperbolic cosine, arc tangent, and hyperbolic tangent (+/-100.0 for the exponential,
+/-200.0 for hyperbolic functions, +/-1.0 for the arc functions), the log functions (must be >0)
and the power function (x must be integral and non-zero when y<0, and 0”0 is undefined).
Square root is undefined for x<0. No filtering is done when these limits are exceeded.

Syntax for an acceptable formulais AS([XY])+bs([xy])...
.up to 80 characters per formula. Algebraic notation is supported to alimited degree. E.G.
you can enter avariable as 2x"2, instead of 2* x*x.

© 2005-2008 -- Mystic Fractal



23

MacOrbits Application Help

6.2

A and B are optional constants.

Sisan optional trig function (1 to three letters: 1 will work for sine, cosine and tangent, but
use the above abbreviations for the other functions. X and Y are the standard variables. The
'+' could be any of the math functions.

The parser interprets up to 10 levels of parenthesis. Use parenthesis to separate complex
expressions. Use parenthesis to embed trig functions within other trig functions, etc.

(3D) Palette Coloring
(3D) Palette Coloring

Atan Coloring
Uses an algorithm by David Makin to color a quaternion image. The angle of each point (as
it escapes the quaternion border) is used to color the image.

Bof60 Coloring

A variation of the Bof60 algorithm found in the classic Pietgen/Ricter text, The Beauty of
Fractals, adapted by David Makin, is used to color a quaternion image. The smallest
magnitude of z (found while calculating the quaternion border) is used to render the image.

Potential Coloring
The escape value of z (at the quaternion border) is used to color the image.

Distance Coloring
The distance of z from zero (at the quaternion border) is used to color the image.

Orbit Traps
These includes methods that trap the orbit of a point if it comesin range of a pre-specified
area or aress.

The Epsilon-Cross method colors points only if the absolute value of Z-real or Z-imaginary is
less than or equal to Epsilon (asmall value.) Other points are mapped at the time they blow
up (exceed the zlimit.) This produces hair-like structures that branch wildly from the
complex set boundaries.

The Globe method uses a circular area around the origin to map a point's orbits. This
produces sphere-like structures.

The Ring method uses an area formed by two circles around the origin to map a point's orbits.
This produces ring-like structures.

The Four-Circles method (Paul Carlson) uses four circular areas to map a point's orbit. This
produces sphere-like structures.

The Square method uses an area formed by two squares around the origin to map a point's
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orbits. This produces ring-like structures with right angles.
The Petal method (Paul Carlson) also uses four trap areas to form flower-like patterns.

Enter avalue for Epsilon and Epsilon2, which are used to define the size of the orbit trap
areas (.001-2.0 and 0.0-epsilon.) The exclude box is used to exclude the first # iterations
from orbit trapping.

Epsilon2 is used to create windows into the stalks. The default value is 0.0, which produces
solid stalks. Epsilon2 has no effect on the Petal method.

Filter

Based on Stephen C. Ferguson's filter algorithms in his program Iterations, this control allows
you to choose one of 26 tail-end filters for surface rendering. Corresponds roughly to its
effect on the basic Mandelbrot-squared set. The effect will vary with the formula and fractal
type chosen.

The Magnify variable is used to intensify or de-intensify the effect of thefilter. Thisvalue
can range from 1-500 nominally.

Click on Draw to apply a new palette-coloring option without closing the window. Click on
Stop to halt the drawing.

Click on Okay to close the window and apply changes. Click on Close to close the window
without applying any additional changes.

6.3 (2D) Pallete Coloring

(2D) Palette Coloring
In this window the following rendering methods are available (for 2D fractals only)

Biomorph

Biomorphstest the real Z and imaginary Z values after breaking the iteration loop. If the
absolute value of either isless than the preset zlimit, the point is mapped as part of the set.
This method produces biological-like structures in the complex plane. Normally the
biomorph tendrils are colored in the set color (the color reserved for non-divergent or inner
points.) With the Set Only flag on, the tendrils are colored according to the color-scaling
option used (other external points are colored in the background color.)
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6.3.1

Decomposition

Toggle the External/Internal Decomposition options for either an external or internal
decomposition. An external decomposition decomposes points that are outside the complex
set. Aninternal decomposition decomposes the complex set. For Mandelbrot/Julia curves, z-
arg is broken into two parts for a binary decomposition.

(Consult The Beauty of Fractals by Peitgen & Richter for a mathematical explanation of
decomposition.)

Binary Decomposition

Optional Coloring Methods
Optional Coloring Options

Inside Coloring Options

Level Curves
Level-curves map the set points based on the value of Z. This alowsthe inside of the
complex set to be color-scaled.

LogMap
produces colored bands on the inside of the complex set. Points are mapped according to
what the value of z is at final iteration.

LogMap

Small Log
produces circular patterns inside the complex set. Points are mapped according to the
smallest value z gets during iteration.
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Small Log

Indexed L og
is mapped according to the escape time it takes z to reach its smallest value.

Indexed Log

Linear Map is mapped like Log Map (with the mapped value of the function at itsfinal
iteration applied to the color palette) and produces 3D-like effects with orbit-trap renderings.
Period uses periodicity to color pointsinside the MS.

Outside Coloring Options

Escape
The Escape option uses the point's escape time.

Escape-time coloring.

L evel
A point is colored based on its logarithmic escape. The QFactor controls the smoothness of
the coloring. A small number from 10-20 works best here..

Log coloring.
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ContinuousPotential
A point is colored based on its continuous potential (when it blowsup.) The QFactor controls
the smoothness of the coloring. A higher number from 2000-20000 or more works best here.

Continuous-Potential coloring.

Angle uses the absolute value of a point's exit angle (theta.) Thisisthe atan method in
Fractint. Angle-Iteration uses the angle formed by the difference between a point's last two
exit values and subtracts the point's escape time. Thisis Paul Carlson's atan method.

Set Only
The Set Only flag plots all outside points in the background color.

Cutoff

This variable acts as a pal ette multiplier or divider, depending on whether the value entered is
less than or greater than 1.0. The palette color is divided by the scaling factor to speed up or
slow down color changes. For level curves and orbit-trap pictures, use a negative cutoff value
to maintain a smooth palette. This ensures that the multiplier is used before the (floating-
point) palette values are converted to (integer) palette indexes. For pictures that use alog
palette (excluding orbit-trap images) avalue of .01 is usually optimal for color scaling. Any
positive value will work for the Continuous Potential method, though a small negative value
will aso produce interesting results. The Escape method can use a small value of .0039 to
.00039 to cover the complete palette. A value of 2.0 to 4.0 works well with the Atan coloring
method.

The Bubble Extensions button selects the Bubble map and Use Level coloring methods, and
sets the Cutoff variable to a small negative value. It also selects a Divide-by-two palette if a
split palette has not already been chosen. (The Palette may need to be redesigned in the
Palette editor to match the split factor.) This automates the process of producing Paul
Carlson's 3-D bubble-like fractals.

The Divide by (1-16) radio buttons are used to assign different colors to the orbit-trap
tendrils. A value of 4 will split the palette into four-color spreads so that tendrils will
alternate through these four color ranges. With a Smooth setting of 0 in the Colors editor, the
Random palette generator will automatically produce a palette suitable for the number of
splitsused. Also useful with bubble and atan pictures. Note: when you choose a different
split factor the color palette needs to be redesigned in the Palette editor. Thisiseasily
automated by using the Random palette button which converts the current palette into one
that is optimal for the split factor.
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6.3.1.1 Potential Log Map

L og M ap produces colored bands on the inside of the complex set. Points are mapped
according to what the value of z is at final iteration.

6.3.1.2 Small Log

Small L og produces circular patterns inside the complex set. Points are mapped according
to the smallest value z gets during iteration.

6.3.1.3 Indexed Log
Indexed L og is mapped according to the escape time it takes z to reach its smallest value.
6.3.1.4 Potential Linear Map

Linear Map is mapped like Log Map (with the mapped value of the function at itsfinal
iteration applied to the color palette) and produces 3D-like effects with orbit-trap renderings.

6.3.1.5 Escape
The Escape option uses the point's escape time to color points outside the Mandel brot set.
6.3.1.6 Use Level

Use Leve -- All points (inside and outside) are colored according to the Level curve
selected or Potential Linear if no level curve is selected.

6.3.1.7 Level

Level -- A point is colored based on its logarithmic escape. The QFactor controls the
smoothness of the coloring. A small number from 10-20 works best here..

6.3.1.8 Continuous Potential

Continuous Potential -- A point is colored based on its continuous potential (when it
blows up.) The QFactor controls the smoothness of the coloring. A higher number from
2000-20000 or more works best here. Deeper zooms require larger g-factor.

6.3.1.9 Atan

Atan uses the angle formed by the difference between a point's last two exit values and
subtracts the point's escape time. Thisis Paul Carlson's atan method.

6.3.1.10 QFactor
QFactor

The QFactor controls the smoothness of the coloring. A small number from 10-20 works best
for Log Palettes, while higher number 2000-20000 or more is best for Continuous Potential.

6.3.1.11 Set Only

Set Only plots al outside points in the background color.
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6.3.1.12

6.3.1.13

6.3.1.14

6.3.2

6.3.2.1

6.3.2.2

Bubble Extensions

The Bubble Extensions button selects the Bubble map and Use Level coloring methods,
and sets the Cutoff variable to a small negative value. It also selects a Divide-by-two palette
if asplit palette has not already been chosen. (The Palette may need to be redesigned in the
Palette editor to match the split factor.) This automates the process of producing Paul
Carlson's 3-D bubble-like fractals.

Cutoff

The Cutoff or color-scaling variable acts as a palette multiplier or divider, depending on
whether the value entered is less than or greater than 1.0. The palette color is divided by the
scaling factor to speed up or slow down color changes. For level curves and orbit-trap
pictures, use a negative cutoff value to maintain a smooth palette. This ensures that the
multiplier is used before the (floating-point) palette values are converted to (integer) palette
indexes. For picturesthat use alog palette (excluding orbit-trap images) avalue of .01 i<
usually optimal for color scaling. Any positive value will work for the Continuous Potential
method, though a small negative value will also produce interesting results. The Iteration
method can use a small value of .0039 to .00039 to cover the complete palette. A value of 2.0
to 4.0 works well with the Atan coloring method.

Divide by

The Divide by (1-16) radio buttons are used to assign different colors to the orbit-trap
tendrils. A value of 4 will split the palette into four-color spreads so that tendrils will
alternate through these four color ranges. With a Smooth setting of 0 in the Colors editor, the
Random palette generator will automatically produce a palette suitable for the number of
splitsused. Also useful with bubble and atan pictures. Note: when you choose a different
split factor the color palette needs to be redesigned in the Palette editor. Thisiseasily
automated by using the Random palette button which converts the current palette into one
that is optimal for the split factor.

Binary

Binary Decomposition
For Mandelbrot/Julia curves, z-arg is broken into two parts for a binary decomposition.
External

External Decomposition

An external decomposition decomposes points that are outside the complex set.
Internal

Internal Decomposition

An internal decomposition decomposes the complex set.
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6.4 Noise command

Noise (Render menu)

Add and/or edit noise factors. The Blend variable determines how much noise is added to an
image. The higher the blend, the more pronounced the noise appears. This also tendsto
darken an image, which can be compensated for by decreasing Gamma. The Grain variable
determines the frequency of the noise. The higher the grain, the noisier the image appears.

Y ou can adjust how the noise maps to an image by changing the scale factors. Higher scale
factors make the image noisier on the respective axis (X, y and z.) Additional variables affect
the type and shaping of the noise data: Gaussian is an alternate form of noise, while Planet,
Check, Tooth, Barber and Wood apply a specific envelope to the noise. The Marble variable
is used to introduce alow frequency or high frequency modulation on top of the noise. You
can achieve marble-like textures by combining a high frequency marble value with alow
frequency Blend value. The marble variable also adds a high-frequency bump map to the
wood envelope.

The Surface Warp variable alows you to apply the same noise to a (quaternion) figure's shape
also. Small values are best for creating realistic surface variations, like stone and wood grain.

To turn off noise, enter '0' for Blend. Use the Apply button to change the current noise factors
for the active figure, if the figure has been drawn recently, or Okay to apply noise factors and
redraw the active figure.

6.5 Texture Scale command

Texture Scale (Render menu)

Opens awindow to edit texture scale factors. The higher the scale factors, the more repetitive
the texture becomes. Y ou can adjust the factors to make the texture asymmetrical on the x, y
or z-axis. Scale A isused to adjust the texture scale for the Atan, Potential and Bof60
coloring options. Click on Apply to apply changes without closing the window, if the image
has been drawn recently. Click on Okay to close the window and apply changes. Click on
Close to close the window, keeping the current changes without redrawing the image.

6.6 Generalized Coloring

Use this command to switch to Steven Ferguson's generalized coloring mode. Images are
colored using algorithmic methods that address the whole rgb spectrum, instead of the

pal ette-based coloring methods. To switch back to palette mode, apply one of the palette-
based options. Use the Apply button to change the current coloring options for the active
figure, if the figure has been drawn recently, without closing the window. Click on Okay to
apply new generalized options and redraw the active figure, or Close to close the window
without applying any additional changes.
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6.6.1

6.6.2

6.6.3

6.6.4

6.6.5

6.6.6

6.6.7

6.6.8

6.6.9

Blend buttons
Various formulas are applied while mapping colors to pixels.
Red/Grn/Blu controls

Red/Grn/Blu controls

Use these diders and edit boxes adjust the color emphasis or red/green/blue mixture of an
image.

RGB button
RGB button

Use red/green/blue mapping for pixels.
RBG button
RBG button

Use red/blue/green mapping for pixels.
GRB button

GRB command (Render menu)

Use this command to use green/red/blue mapping, if in the generalized coloring mode.
GBR button

GBR command (Render menu)

Use green/blue/red mapping for pixels.
BRG button

BRG command (Render menu)

Use blue/red/green mapping for pixels.

BGR button

BGR command (Render menu)

Use blue/green/red mapping for pixels.
Sine algorithm button

SineAlgorithm command (Render menu)

When color values exceed the range of rgb components, the values are scaled with Steven C.
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6.6.10

6.6.11

6.6.12

6.6.13

6.7

Ferguson's sine algorithm.

Sawtooth algorithm button

Triangle Algorithm command (Render menu)

When color values exceed the range of rgb components or palette indexes, the values are
scaled with atriangle algorithm, or linear ramp.

Gray Scale button
Gray Scale button

Color the active image with gray tones.
Invert button

Invert command (Render menu)

Invert image colors.
Fractal Dimension button

Fractal Dimension command (Render menu)

Generalized fractal dimension agorithm (S. Ferguson), for use with any blend option.
Orbit Trap

This includes methods that trap the orbit of a point if it comes in range of a pre-specified area
or areas.

The Epsilon-Cross method colors points only if the absolute value of Z-real or Z-
imaginary is less than or equal to Epsilon (asmall value.) Other points are mapped at the time
they blow up (exceed the zlimit.) This produces hair-like structures that branch wildly from
the complex set boundaries.

The Globe method uses a circular area around the origin to map a point's orbits. This
produces sphere-like structures.

The Ring method uses an area formed by two circles around the origin to map a
point's orbits. This produces ring-like structures.

The Four-Circles method (Paul Carlson) uses four circular areas to map a point's orbit.
This produces sphere-like structures.

The Square method uses an area formed by two squares around the origin to map a
point's orbits. This produces ring-like structures with right angles.

The Petal method (Paul Carlson) also uses four trap areas to form flower-like patterns.

The Astroid method (Paul Carlson) uses the atan function to create an orbit trap based
on exit angles.

The Chains method is a variation of the Rings method, where the ring stalks have a
non-uniform width.
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6.7.1

6.7.2

6.7.3

6.7.4

6.7.5

The Bullet method is based on the magnitude of z, where points are colored when z is
less than epsilon.

Epsilon2 is used to create windows into the stalks. The default value is 0.0, which produces
solid stalks.

To produce the maximum 3-D effects (as Phil Pickard and Paul Carlson do) with these
options, Level Curve Linear Map must be set, and the Cutoff value (in the Parameters
window) should equal the negation of the epsilon value (-epsilon.) You'll need to set up a
specia palette with a number of color ranges that matches the split-palette number if set.

To automate the process of producing Paul Carlson's 3-D like fractals, a button has
been added to this window for 'Carlson extensions. This sets the Set Only flags as well asthe
Level Curve Linear Map and the cutoff value, and sets the Mapping to <Abs(Z-Real) or
Abs(Z-Imag). An exclude value of 2 isalso used. The Mapping and exclude values are extra
parameters that Paul usesin some of hisformulas, and may be omitted in other cases.

Epsilon

Outside Radius
The Outside Radius variable is used to define the size of the trap areas. Start with .02 and
increase or decrease to taste.

Epsilon2

Inner Radius
The Inner Radius variable opens awindow inside the "stalks" or trap areas.

Exclude

Exclude

Use Exclude to skip the first n# iterations from the trap zone. Thisis sometimes necessary
with the Epsilon orbit method, to eliminate stray stalks and clarify the image.

Epsilon Cross

Epsilon Cross
The Epsilon-Cross method colors points only if the absolute value of Z-real or Z-imaginary is
less than or equal to the Outer Radius (a small value.) Other points are mapped at the time
they blow up (exceed the zlimit.) This produces hair-like structures that branch wildly from
the complex set boundaries. Note: Epsilon pictures use palette index 255 for the background
color.

Globe

Globe
The Globe method uses a circular area around the origin to map a point's orbits. This
produces sphere-like structures
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6.7.6

6.7.7

6.7.8

6.7.9

6.7.10

6.7.11

6.7.12

6.7.13

6.8

Ring

Ring
The Ring method uses an area formed by two circles around the origin to map a point's orbits.
This produces ring-like structures.

Square

Square

The Square method uses an area formed by two sguares around the origin to map a point's
orbits. This produces ring-like structures with right angles.

Petal

Petal
The Petal method (Paul Carlson) also uses four trap areas to form flower-like patterns.

Four Circles

Four Circles
The Four-Circles method (Paul Carlson) uses four circular areas to map a point's orbit. This
produces sphere-like structures. .

Astroid

The Astroid method (Paul Carlson) uses the atan function to create an orbit trap based on exit angles.
Chains

A variation of the Rings orbit-trap method.

Bullet

An orbit trap based on the magnitude of z.

Carlson Extensions

The Carlson Extensions button selects the Set Only flag as well as the Linear map
coloring method, and sets the Color Scaling variable to «Orbit-trap) Radius*1.2. This
automates the process of producing Paul Carlson's 3-D like fractals, when used in conjunction
with an orbit-trap method (see MS Rendering dialog.)

Biomorph

Biomor ph

Biomorphstest the real Z and imaginary Z values after breaking the iteration loop. If the
absolute value of either isless than the preset zlimit, the point is mapped as part of the set.
This method produces biological-like structures in the complex plane. Normally the
biomorph tendrils are colored in the set color (the color reserved for non-divergent or inner
points.) With the Set Only flag on, the tendrils are colored according to the color-scaling
option used (other external points are colored in the background color.)
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6.9

6.10

Newton

Newton
The Newton flag is used to map the zeros of a particular function after the Newton
transformation has been applied to the function. The program doesn't make the
transformation (z-(f(z)/f'(z)), where ' stands for d/dx). When a built-in formula (or custom
formula) is chosen that doesn't contain this transformation, the bailout is checked for
convergence only.

Thisflag is mutually exclusive with the Renormalization flag, and automatically excludes all
points that don't converge to one of the attractors set, within the preset number of iterations.
The points that converge are colored according to the root they converge to and the time it
takes to converge. The non-converging points are mapped with the set color or their level set
color (with alevel flag set) after the maximum number of iterations. Non-converging points
show up typically as round areas or spots.

Generaly, alimit of 50 iterations gives optimum results. The Newton transformation is
normally used with Julia sets, as the attractors (solutions of the formula) can be calculated
beforehand. It's aso possible to explore the Mandelbrot set applied to Newton's method, but
only with some of the built-in formulas mentioned above. It this case, the solutions of the
formulafor every point on the screen have to be calculated separately, which the program
does in a dedicated routine.

Renormalization

Renor malization
The Renormalization flag uses a hierarchical lattice transformation to map magnetic phases,
with either the Julia set or Mandelbrot set as the iterated function. (Consult The Beauty of
Fractals by Pietgen and Richter for appropriate formulasto use.) Basicaly, the default-
mapping algorithm checks orbits for convergence to 1 or infinity, and scales these points in
different colors. Thisflagis mutualy exclusive with the Newton flag. The default method of
display actually only checksif z passes through 1. Thisis similar to the epsilon-cross
mapping method. For the original renormalization formulas, there is a strong orbital
attraction to 1. For other functions, this mapping produces unusual effects (with obscure
mathematical foundations.) For the built-in functions, the convergence tests (type 2 or 3 and
6-8 display types) are the same as the ones used with the Newton flag. So either method
produces similar results with the same formula. The differences are worth playing with,

Original picture
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With renormalization

7 Demo Menu
Demo menu commands

The Demo menu offers the following commands, which illustrate various features of

MacOrbits:

Random Quaternion Generate random quad fractal.

Random Quat-Trap Generate random quat-trap fractal.

Random Stalks Generate random orbit-trap fractal.

Random Bubbles Generate random bubble fractal.

Random Newton Generate random Julia fractal using Newton method.
Random Halley Generate random Julia fractal using Halley's method.
Random Composite Generate random composite Julia fractal.

Random Mandelcloud Generate random Mandelbrot Cloud fractal

Random Juliacloud Generate random Julia Cloud fractal

Random Render Select arandom rendering.

Random Setup Set preferences for random commands.

7.1 Random Quaternion

Random Quater nion (Demo menu)
A random quad fractal is generated. A set of formulas appropriate for quaternions is scanned

to find an interesting Julia quad set, and then the parameters are adjusted to produce the
image. The quad type generated is the Type selected from the Type menu.

7.2  Random Quat-Trap

Random Quat-Trap (Demo menu)
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7.3

7.4

7.5

7.6

7.7

A random quat-trap fractal is generated using one of the orbit trap methods and a quaternion
formula. Thisisahybrid fractal combining aspects of both orbit trap and 3D quaternion. The

orbit trap part controls the overall shape of the image generated, while the quaternion part
adds depth and lighting to the final image.

Random Stalks

Random Stalks (Demo menu)

A random Juliafractal is generated using one of Paul Carlson's orbit traps.
Random Bubbles

Random Bubbles (Demo menu)

A random Juliafractal is generated using one of Paul Carlson's bubble method.

Random Newton

Random Newton (Demo menu)

A random Juliafractal is generated using Newton's method.

Random Halley

Random Halley (Demo menu)

A random Juliafractal is generated using Halley's method.

Random Composite

Random Composite (Demo menu)

A random Julia quad fractal is generated using one of the composite Types. Two formulas are
selected at random and mixed using one of Types 2-8. This option can be applied to all built-
in formulas, except the Gallet formulas (90-99.)
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7.8

7.9

7.10

7.11

8.1

Random Mandelcloud

A random Mandelbrot Cloud fractal is generated using any of the built-in formulas or a custom
formula.

Random Juliacloud
A random Julia Cloud fractal is generated using any of the built-in formulas or a custom formula.

Random Render

Random Render (Demo menu)

The rendering options for the current fractal are randomized. Does not affect formula or
range variables. For quaternion images, arandom coloring filter is applied, if palette coloring
is selected, else the generalized coloring parameters are randomized..

Random Setup

Random Setup (Demo menu)
Here you customize random variables to direct how the random scanning process works.

There are radio boxes that allow you to customize how random variables are processed to
create new fractals:

Formula -- (default on) check to randomize built-in formula used

Z-Space -- (default on) check to set default z-space

Constants -- (default on) check to randomize the complex constants cj-ck

Custom Formula -- (default off) check to generate arandom formula -- n/awith the
Random Newton and Random Halley options

Orbit Trap -- (default off) check to randomize the orbit trap

These settings are saved in a"prefs’ file in the startup directory.

Video Menu

The Video Menu offers the following commands:

Write Movie Write frames to QuickTime movie file.
Add Frame Add current image to frame buffer.
Edit Frames Edit frame buffer.

Load Frames [QFRM] Load frame buffer.
Save Frames [QFRM] Save frame buffer.

Write Movie

With this command the video frame buffer is written to a QuickTime movie. First you choose the
width of the video, up to 2048 (height is determined by the current image aspect or
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8.2

8.3

8.4

8.5

8.6

height=width*aspect.) A file requester is then opened to choose the name and location of the movie,
then the frames are written sequentially in the mov format. Variables are scaled between buffer
frames to create the illusion of motion or morphing. The movie is written in the highest quality
possible, so there are minimal compression artifacts. (The movie can be compressed later in an
external QuickTime program to reduce file size, if necessary.) Most variables that have a numerical
value can be scaled between frames.

Add Frame

MacOrbits uses a frame buffer to compose an animation. You add key frames to the buffer with this
command. Each key frame is identical to the active image. Change variables between key frames to
create the illusion of motion or morphing. You can edit the frames with the frame editor.

Edit Frames

Here you can edit any frames in the video buffer. Buttons are supplied to access all the image
parameter editors, such as Function, Lighting and Parameters. The Move button allows you to move
a frame from one spot in the buffer to another. You can change the frame image being edited by
using the Frame slider or Edit box. After changing frames, use the Preview button to display the
current frame being edited. In most cases the frame preview is automatically updated when you
change an image parameter using the editor or type buttons. The Delete button allows you to delete
all but two of the frames, the minimum number of frames to create a movie. (If you want to delete all
the frames, use the Video/Reset Frames command.)

Reset Frames

Delete the current frame buffer. The number of video frames is reset to zero.
Load Frames [OFRM]

Load a frame buffer that has been previously saved by MacOrbits. The buffer replaces any existing
frame buffer.

Save Frames [OFRM]

This command saves the current frame buffer in a [ofrm] file. A file requester is opened that allows
you to choose the location and name of the frame library. The frame buffer files can also be used as
image libraries, similar to Fractint's par and frm formats. The frames contain all the information to
reproduce an image at any supported size.

Help Topics

Help topics
Getting Started Tutorial for new users of MacOrhits.
Tutoria An introduction to CQuat fractals

Parser Information  Quick reference to MacOrbits's parser variables and functions.
Built-in Formulas Quick reference to MacOrbits's built-in formulas.

Bibliography Sources for fractal information and complex numbers.
About MacOrbits Displays the version number and author info for this application.
Chronology History of the programs preceding MacOrbits
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9.1  Getting Started
Getting Started

Welcome to MacOrbits!

Thisisashort tutorial that will cover basic commands and background material necessary for
auser to create a drawing or model with MacOrbits.

Start by changing the type of the fractal to Mandelbrot or MandelbrotP using those commands
in the Type menu. The Mandelbrot border is often used as a map to find the most interesting
Juliasets. Use Image/Scan command to turn on quaternion/Julia exploratory mode. If you
left-click inside the draw window, the left-hand corner of the image will be erased, and a
miniature version of the Julia set that uses that zspace as its constants will be drawn. Y ou can
continue to click on areas of the draw window and see what Julia set lies there, or you can
press the space bar to open a new window and draw the Julia set full-size. Click in the
status_bar area of the window to exit this mode without creating a new window.

Once you find an interesting 2D Juliafigure, you can change it into a 3D figure just by
changing the Type to Quaternion or one of the other 3D types. Thisfigure can be converted
to a3D object by using any of the Export commands in the File menu, such as

Save Quaternion to [obj]. The precision of the object is controlled by the Steps variable in
the Parameters window, so to get a smooth object you'll need to increase the number of steps
from its 200 default value. For afully defined object Steps may need to be increased to 800
or more. Be careful with thisthough, as the size of the object file can increase exponentially
depending on the Export setup.

Other 3-D Typesin MacOrbits include hypernions and cquats. It's easy to switch from
quaternion to hypernion using the Type menu. Most hypernions exhibit squared-off shapes
rather than the round quaternion shapes. For a good preview of what MacOrbitsis capable
of, be sure to experiment with all of the Demo/Random commands.

MacOrbits allows you to Undo the last command in most cases.
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9.2

This completes the Getting Started tutorial. Be sure to read the Parser Information and Built-
in Formulas sections for additional info. The Bibliography lists additional reference material
for a better understanding of the fractal types and functions contained in MacOrbits.

Tutorial

An Introduction To CQuat FractalsBy Terry W. Gintz

In the process of exploring all possible extensions to afractal generator of thistype, |
considered using discrete modifications of the standard quaternion algebrato discover new
and exciting images. The author of Fractal Ecstasy [6] produced variations of the
Mandelbrot set by altering the discrete complex algebra of Z2+c. The extension of thisto
quad algebrawas intriguing. There was also the possibility of different forms of quad algebra
besides quaternion or hypercomplex types.

Having modeled 3D fractals with complexified octonion algebra, as described in Charles
Muses non-distributive algebra[7], it was natural to speculate on what shapes a
"complexified" quaternion algebra would produce. Would it be something that was between
the images produced with hypercomplex and quaternion algebra? Quaternion shapes tend to
be composed of mainly rounded lines, and hypercomplex shapes are mainly square (see
Figures1land 2.)

Figure 2. Hypercomplex Julia set of -1+0i
For those not familiar with the basics of hypercomplex and quaternion algebra, here are the
algebraic rules that define how complex components interact with each other:
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Table 2 Quaternion variable multiplication rules

In both quaternion and hypercomplex algebra, i2=-1. The hypercomplex rules provide for one
real variable, two complex variables, (i and j) and one variable that Charles Muses refersto as
countercomplex 